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GETTING STARTED WITH SIMULINK

1.1 INTRODUCTION

This chapter describes the basic steps to be followed in building a Simulink
model. The model presented in this chapter is a simple one: generation of
a sinusoidal signal. This presentation uses MATLAB 2014a1, incorporating
Simulink and blocks extracted from the Simulink Library Browser. Sub-
sequent chapters will utilize blocks from the Simulink Library Browser
including the Communications System Toolbox and the DSP System
Toolbox. The Communications System Toolbox provides a collection
of MATLAB functions and simulation blocks that can be utilized for a
wide range of digital communications systems simulation models. While
MATLAB and Simulink are available for a variety of operating systems, all
of the descriptions and examples presented in this book are implemented on
Windows-based computers.

A comprehensive presentation of MATLAB® and Simulink® by
The MathWorks™ is available at http://www.mathworks.com/help/. Product
descriptions from this documentation are provided as follows:

1Every model presented in this book executes successfully in MATLAB 2014a. In some
instances, a notice is generated indicating that the model was developed in an earlier release.
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MATLAB®

MATLAB® is a high-level language and interactive environment
for numerical computation, visualization, and programming. Using
MATLAB, you can analyze data, develop algorithms, and create models
and applications. The language, tools, and built-inmath functions enable
you to explore multiple approaches and reach a solution faster than with
spreadsheets or traditional programming languages, such as C/C++
or Java®. MATLAB is an abbreviation for “matrix laboratory.” While
other programming languages mostly work with numbers one at a time,
MATLAB is designed to operate primarily on whole matrices and
arrays.

Simulink®

Simulink® is a block diagram environment for multidomain simulation and
Model-Based Design. It supports system-level design, simulation, auto-
matic code generation, and continuous test and verification of embed-
ded systems. Simulink provides a graphical editor, customizable block
libraries, and solvers for modeling and simulating dynamic systems. It is
integrated with MATLAB, enabling you to incorporate MATLAB algo-
rithms intomodels and export simulation results toMATLAB for further
analysis.

Upon gaining familiarity with Simulink, the user will discover that
multiple paths can be followed in developing a Simulink model. The choice
of the path is left to the user but each path will lead to the same solution.

The topics covered in this chapter are:

• Starting a MATLAB session
• Viewing Simulink block libraries
• Building a new Simulink model
∘ Setting simulation parameters
∘ Setting and using Scopes

• Executing the model
• Sending data to Workspace
• Using the Model Explorer
• Selecting Model Configuration Parameters

1.2 STARTING A MATLAB SESSION

To start a MATLAB session on a Windows machine, simply double-click on
theMATLAB icon; this will open theMATLABdesktop, shown in Figure 1.1.
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The default desktop view shown in this text includes four panels. (Other desk-
top views may be selected under the Home menu; see the Layout tabs on
the toolbar.) The left-hand panel displays the Current Folder, which can con-
tain MATLAB or Simulink models in addition to user-developed figures and
user files resident in the folder. The center panel is the Command Window,
where the user inserts MATLAB commands, assigns values to model parame-
ters, and performs calculations using MATLAB mathematical functions. The
upper right-hand panel is theWorkspace, where variables defined in the Com-
mandWindow are displayed, and the lower right-hand panel is the Command
History, where the user can view or rerun commands entered at the command
line. In Figure 1.1 the bar above the Command Window is labeled here as
▸ C: ▸ Users ▸ Default User

The path can be changed to a different folder. At the end of this bar the
symbol ▾ also allows the path to be changed to a previous selection.

1.3 SIMULINK BLOCK LIBRARIES

Building a Simulink model consists of selecting individual blocks contained
in libraries and joining them in a block diagram of the system to be simulated.

Items under new include: 

• MATLAB script 
• Simulink model 

Simulink
library 

Figure 1.1 MATLABDefault Desktop View. Reprinted with permissions from The
MathWorks™, Inc2.

2This Simulink parameter window and similar figures appearing throughout the book are all
reprinted with permissions from The MathWorks™, Inc.
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Figure 1.2 Simulink Block Library.

To view available blocks, select Simulink Library on the MATLAB toolbar.
This opens the window shown in Figure 1.2.

The Simulink Library Browser shows a listing of available Simulink
blocks. The focus in this book is on modeling digital communication
systems, and the blocks you will find most useful are contained in the basic
Simulink block library as well as in the Communications System Toolbox
and the DSP System Toolbox.

Simulink library blocks used throughout this book are listed here.

Simulink

• Commonly used blocks
∘ Constant
∘ Delay
∘ In1 & Out1
∘ Scope
∘ Math operations

– Abs
– Sum
– Product
– Complex to Real-Imag
– Math Function

∘ Model Wide Utilities
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– Model Info
∘ Signal Routing

– From
– Goto
– Mux

∘ Sinks
– Display
– Scope
– To Workspace

∘ Sources
– Constant
– From Workspace
– Random number
– Sine Wave

∘ User-Defined Functions
– Matlab Function

• Communications System Toolbox
∘ Channels

– AWGN
– Multipath Rayleigh Fading

∘ Comm Sources
– Noise Generators

◽ Gaussian Noise Generator
– Random Data Sources

◽ Bernoulli Binary Generator
◽ Random Integer Generator

∘ Error Detection & Correction
– Block
– Convolutional

∘ Modulation
– Digital Baseband Modulation

◽ AM (QAM)
◽ PM (BPSK,QPSK,M-PSK)
◽ FM(M-FSK)

• DSP System Toolbox
∘ Filtering
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– Adaptive Filters
◽ Block LMS Filter
◽ Kalman Filter
◽ RLS Filter

∘ Signal Management
– Buffers
– Sinks

◽ Spectrum Analyzer
◽ Time Scope
◽ Vector Scope

– Sources (DSP Sine Wave)
– Statistics

◽ Mean
◽ Variance
◽ Autocorrelation
◽ Correlation

– Transforms
◽ FFT
◽ IFFT

Appendix A lists principal Simulink blocks used in Chapters 1–13.

1.4 BUILDING A NEW SIMULINK MODEL

To begin building a new Simulink model, on the MATLAB toolbar, under the
HOME tab, pull down New and select Simulink Model. This will open a
blank Simulink model window, shown in Figure 1.3. Note that on the title bar
at the top of the window, this model is labeled untitled. In the model window,
the usermay select the duration of themodel execution, shown here to be set at
10.0 s. This will fix the duration of each of the simulations to be demonstrated
in this chapter.

To rename themodel, on the toolbar, selectFile or File:save as and enter
the model name First_Simulink_Model, then save. The renamed model
is shown in Figure 1.4.

1.4.1 Inserting Signal Source and Scope

The model can be constructed either by selecting blocks from the Simulink
Library Browser or by copying blocks from an existing model. Here, blocks
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Model is untitled

Model duration set
to 10.0 s

Figure 1.3 Simulink Model Blank Window.

New model name
Opens the
Simulink Library
Browser 

Figure 1.4 Simulink Model Window Renamed First_Simulink_Model.

will be copied from the library, which can be opened from the model window
by clicking on the four-symbol icon on the toolbar shown in Figure 1.4. First,
in the library window (Figure 1.2), click on Sources to open the window
shown in Figure 1.5.With both the First_Simulink_Modelwindow and the
Simulink Library Browser window open, left-click on the Sine Wave icon
and drag a copy into the model window. Alternatively, you can right-click on
the icon in the library and select Add to First_Simulink_Model.
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Figure 1.5 Simulink Library Browser with Sources Selected.

Next, add a scope to the model by returning to the Simulink Library
Browser and clicking on -Sinks, selecting scope, and dragging a copy into
the model window, now shown in Figure 1.6. In the figure, the Sine Wave
block has been connected to the Scope by clicking on the arrowhead at the
Sine Wave output and dragging a line to the corresponding arrowhead at
the input to the Scope.

Another block, entitledModel Info, is shown in Figure 1.6 and is available
in the Simulink library under Simulink Model-Wide Utilities. Dragging
this block to the First_Simulink_Model and double clicking on this block
opens a text box. This utility is very useful for conveniently displaying the
parameters of each simulation model and identifying pertinent information
about the model.

1.4.2 Setting the Source Block Parameters

In the model window, double-click on the Sine Wave icon; this opens an
information window for the Sine Wave block, shown in Figure 1.7. In the
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Connect the source to the scope by 

clicking and dragging a line left-to-right 

between the arrowheads

Figure 1.6 Simulink Model With Sine Wave Source, Scope, and Model Info
Blocks.

window, the Amplitude and Bias of the sinusoidal source are selected
as 1 and 0, respectively. The Sine type and Time (t) selections shown in
the figure will be suitable for most simulations. The Sine Wave block
parameters window can also be opened by selecting the block in the model
window and right-clicking the mouse, which displays a list of options, and
selecting Block Parameters (Sin). This same pull-down menu provides
options to manipulate and/or format the selected block, which the user will
find helpful in structuring block diagrams in Simulink models.

The user will normally find options that can be selected for each block
in addition to entering parameter values. As an example, in this block the
user has a choice under Sine type to select either Time-based or Sample-
based computation; under Time (t) the user can select Use simulation
time or Use external signal. To provide a stream-lined introduction to
model building, the presentation in this text will omit detailed discussions
of many options. The Simulink documentation, accessible by clicking on the
Help button, provides more extensive information on the optional selections.

1.4.3 Setting Scope Parameters

In the model window, double-click on the Scope icon, opening the Scope
display, shown in Figure 1.8. At this point, the display is blank, since no
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Figure 1.7 Information Window for the Sine Wave Source Block.

simulation has been started with this model. The gear-like icon on the toolbar
opens the Scope Parameters window, which has three pages. On the
General page, shown in Figure 1.9, the user is able to set the number of
axes to be displayed in the Scope display, the simulation time range to be
displayed, and to specify where Tick labels are to be applied in the display.
Since the scope can be set to display multiple axes (for multiple inputs),
the time ticks might be applied to all axes (select all), or to none, or to the
bottom axis only.

The History page of the Scope Parameters window is shown in
Figure 1.10. Here the user can specify the number of simulation data
points to be displayed on the scope and can elect to have the data stored
to workspace. On the Style page of the Scope Parameters window,
shown in Figure 1.11, the user has various options as to colors, line styles
and choice of markers to be used in the scope display.
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Opens Scope Parameters Window

Figure 1.8 Scope Display.

Figure 1.9 Scope Parameters Window: General Page.

1.5 EXECUTING THE SIMULINK MODEL

To execute the simple Sine Wave model, in the model window, click on
the dark arrow button near the center of the toolbar, as shown in Figure 1.12.
Double-clicking on the Scope block opens the Scope display window,
shown in Figure 1.13. Examining the signal trace on the Scope display
confirms the signal source settings made in Figure 1.7: Amplitude = 1, and
Frequency = 1 rad/s.
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Figure 1.10 Scope Parameters Window: History Page.

Figure 1.11 Scope Parameters Window: Style Page.

In this model, under the Display tab, selecting Sample Time and then
all adds a data label Cont indicating that continuous time has been chosen, a
direct result of choosingSine type as Time based in Figure 1.7. Themodel
colors are now changed, as seen in Figure 1.14, where the Sine Wave and
Scope blocks are black and theModel Info block is magenta.

A Sample Time Legend is also displayed, as shown in Figure 1.15,
indicating the block colors, the data type and the data values. In this case, the
Sine Wave block is black, labeled Cont for continuous with a zero value;
the Model info block is magenta with data value and type Inf, indicating
that there is no time associated with this block, that is, it exists as long as the
simulation is active.
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Execute Simulink model

Figure 1.12 Executing the Simulink Model.

Note: One cycle completed

in 6.28 seconds

Figure 1.13 Scope Display After Executing the Sine Wave Model.
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Figure 1.14 Model After Selecting Sample Time Under Display Tab.

Figure 1.15 Sample Time Legend Indicating Block Characteristics.

1.6 RECONFIGURING THE SIGNAL BLOCK

At this point, another model change will be used to demonstrate an important
feature of Simulink: Simulink blocks are designed to accept signals and
parameter values as vector inputs. As an example, the time-based Sine
Wave model in Figure 1.14 can be modified to generate two sinusoids
instead of just one. A simple way of doing this is double-clicking on the
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Figure 1.16 Sine Wave Model For Generating Sinusoids at 1 and 10 rad/s.

Sine Wave block, opening the block parameters window, and changing
the frequency (rad/s) setting by inserting the two-element vector [1 10].
This configures the Sine Wave block to generate two sinousoids, one at
1 rad/s, the other at 10 rad/s. This change creates a new model, here renamed
First_Simulink_Model_freq_f, shown in Figure 1.16. Note in the model
window that the Sine Wave output is labeled 2D1 and the input to the
Scope is labeled 2, both resulting from setting the frequency to the vector
value [1 10].

After running the simulation, the Scope will display the two sampled
sinusoids, as seen in Figure 1.17. To generate more frequencies with theSine
Wave block, simply add more terms in the vector input for the frequency
(rad/s) cell in the parameters window.

Figure 1.17 Scope Display for First Simulink Model with Frequency Set to [1 10].
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Another way of configuring the Sine Wave block to generate the two
sinusoids is to specify the frequency (rad/s) as f in the block parameters
window, and define the variable f by inserting the statement f = [1 10] into
the MATLAB Command Window. A third way of reconfiguring the Sine
Wave block is discussed in Section 1.9, where the use of Model Explorer
is demonstrated.

1.7 SAMPLE-BASED SIGNALS

In Figure 1.18, the simulation model is changed by selectingSample based
in the Source Block Parameters: Sine Wave window; the Sample
time is set to 0.1 (where the units are seconds) and the number of samples

Figure 1.18 Sample Based Selection in Sine Wave Block.
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Figure 1.19 First Simulink Model Modified for Sample Based computation.

Figure 1.20 Sample Time Legend for Sample Based Computation.

per period is set to 10. Figures 1.19 and 1.20 display, respectively, the
sample-based model and the Sample Time Legend resulting from the
change. The color red in the blocks and data line indicates that the output
from the Sine Wave block is a discrete vector with 0.1 s time steps and the
magenta color shows inf corresponding to an infinite associated time.

Upon running the simulation, the scope output, shown in Figure 1.21, dis-
plays the resulting sample values as a function of time (Note: labeling of axes
is discussed in a later section.)
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Figure 1.21 Scope Display for Sample-Based Computation.

Figure 1.22 Sending Simulation Data to Workspace.

1.8 SENDING DATA TO WORKSPACE

In Figure 1.22, First Simulink Model-sample-based has been aug-
mented by adding the To Workspace block from Simulink Sinks while
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Figure 1.23 Partial Output for the Variable simout.

retaining sample based computation; the model has been renamed by saving
it as First_Simulink_Model_simout. The To Workspace block causes
the output data from the Sine Wave block to be saved and examined for
subsequent use such as plotting. The output block is labeled here as simout,
a label that can be changed after first double clicking on the block. After
running the model, the simulation results are retrieved by clicking on the
variable simout in the MATLAB Workspace window. Figure 1.23 shows
partial output data for the simulation, where both the time increments and
sampled sine wave data values are displayed.

1.9 USING MODEL EXPLORER

Model Explorer is a tool available to provide the user with the ability to
view, modify or add elements in the Simulink model and workspace vari-
ables. Refer to the MathWorks documentation for further information on the
use of Model Explorer.

To open the Model Explorer, select Model Explorer under the View
tab in the Simulink model window. Figure 1.24 shows the window displayed
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Figure 1.24 Model Explorer Window for First_Simulink_Model_freq_f.

Figure 1.25 Model Explorer Showing Sine Wave Block Information.

after performing this selection from the First_Simulink_Model_freq_f
model window of Figure 1.16. Themenu in the center panel lists all the blocks
in the selected model.

By clicking on any model block in the list, the user can display information
about that block. For example, Figure 1.25 displays information for the Sine
Wave block, where the frequency parameter f is seen.

This provides another avenue for reconfiguring the Sine Wave
block to generate multiple frequencies, discussed earlier. That is, the
First_Simulink_Model_freq_f could have been modified in the Model
Explorer window by setting frequency (rad/s) to [1 10]. To accomplish
the task of setting the frequency parameter f, open the Callbacks tab in the



ADDING LABELS TO FIGURES 21

Figure 1.26 Frequency Parameter f set in Model Explorer Callbacks Preloadfcn*.

right-hand panel of theModel Explorerwindow, and in the PreLoadFcn*
enter f = [1 10] as seen in Figure 1.26.

1.10 ADDING LABELS TO FIGURES

The Simulink scope block does not support the manipulation of graphics
properties in scope displays. To add labels to Figure 1.17 the following snip-
pet of Matlab code is used3:

shh = get(0,’ShowHiddenHandles’);
set(0,’ShowHiddenHandles’,’On’);
set(gcf,’menubar’,’figure’);
set(gcf,’CloseRequestFcn’,’closereq’);
set(gcf,’DefaultLineClipping’,’Off’);
set(0,’ShowHiddenHandles’,shh);

Entering this snippet in the the MATLAB Command Window displays an
Edit tab in the figure. Selecting Figure Properties from the Edit tab pro-
duces the window shown in Figure 1.27. Changes can now be made to colors,
style, axis properties, and labels.

After adding labels, inserting a title, and changing colors, the revised figure
is displayed in Figure 1.28.

3This snippet of MATLAB code was provided by the MathWorks technical staff.
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Figure 1.27 Figure Properties Window.
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Figure 1.28 Relabeled Scope Output Display.

1.11 SELECTING MODEL CONFIGURATION PARAMETERS

In the Simulink model window, pulling down the Simulation tab and select-
ing Model Configuration Parameters opens a window where the user



SELECTING MODEL CONFIGURATION PARAMETERS 23

Figure 1.29 Model Configuration Parameters for First Simulink Model.

can specify the simulation start and stop time and choose the solver for the
simulation4. Figure 1.29 shows the Model Configuration Parameters
for First_Simulink_Model where the Type of solver is set to Variable-
step and the Solver is selected as ode-45(Dormand-Prince), which, in
general is the best first choice as a solver for most Simulink models. By click-
ing on the Help button in the Model Configuration Parameters win-
dow, the MathWorks documentation describes several aspects of this window
including:

• Solver choices
• Simulation and clock time are not the same
• Fixed-step and variable-step size
• Shortened simulation time with variable-step solver

For both fixed-step and variable-step solvers, the next simulation time is the
sum of the current simulation time and the step size. Using a fixed-step solver,
the step size remains constant throughout the simulation whereas use of a
variable-step solver allows the step size to vary from step to step in accordance
with the specified error tolerance.

4Simulink provides a variety of solvers, each appropriate for running a particular type of simu-
lation model. Detailed discussions of the various solvers can be found in Dabney and Harmon,
and in Jamshidi, Farzad and Pedar, cited in Appendix B.
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Figure 1.30 Error Diagnostic Caused by Variable-Step Solver.

If the First_Simulink_Model is modified where the Sine Wave block
is chosen to have a Sample-based Sine type and a 0.1 s Sample time
is entered, the model execution will produce a warning message seen at the
bottom of the Simulink model. The error diagnostic explains the problem as
seen in Figure 1.30.5

In Figure 1.31, the Solver is changed to Fixed-step in the Solver type
tab and discrete in the Solver tab so that no error message is generated.

1.12 SUMMARY DISCUSSION

This chapter has presented a brief introduction to Simulink by demonstrat-
ing the basic steps to be taken in constructing a simple simulation model. The
MathWorks documentation provides a comprehensive treatment of each block
and available tools. The remaining chapters focus on the use of Simulink
for modeling digital communications systems, without delving deeply into
aspects of the full Simulink capability. Other references that the user is likely
to find helpful are listed in Appendix B.

5Error diagnostics are often generated when a simulation is first developed. Care must be taken
by the user in that the error message identifies a problem but the solution may reside in a block
other than the highlighted block. The Simulink toolbar has a check button that can invoke the
Model Advisor to help the user correct the problem.
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Figure 1.31 Model Configuration Parameters with Solver Changed to Fixed-Step
Discrete.

PROBLEMS

1.1 Modify the Simulink model in Figure 1.12 to produce two sinusoidal
waves with the following parameters:

frequency = 1 rad/s for both waves
amplitude = 1V for both waves
phase = 0 for one wave and 𝜋/2 for the second wave
sample time = 0.01 s

a. Show the Simulink Model and include an information block.

b. Display each wave on a separate trace in the scope and label all axes.

Hint: Find the demux block in the Simulink library.

1.2 Let x(t) = 4
𝜋

[
sin (t) + 1

3
sin(3t) + 1

5
sin(5t)

]
.

a. Develop a Simulink model for x(t) with an included information
block. Assume a 10 s simulation time.

b. Display x(t) in a scope over the range 0 to 2 𝜋 with labels.
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c. Modify the Simulink model obtained in part a by overlaying a square
wave that is +1 between 0 and 𝜋 and −1 from 𝜋 to 2𝜋 and repeats
thereafter.

d. Display the overlay result in a scope over the range 0 to 2 𝜋 with
labels.

Note that x(t) represents the first three terms of the Fourier series of
the square wave.

1.3 Amplitude Modulation (AM) with a tone modulator having a unity mod-
ulation index is expressed as

x(t) = (1 + cos(t)) cos(20t)

a. Develop a Simulink model for x(t) with an included information
block. Use a 10 s simulation time and Goto and From routing blocks
from Signal Routing to simplify the model.

b. Display x(t) and cos(t) on a scope with labeled axes.

c. From the Simulink library, add an AM modulation block to the simu-
lation and form the difference between x(t) and the output of the AM
library block.

d. Display x(t), cos(t), the AMblock output and the difference on a scope
with four traces. Insert x axis title on bottom trace only; do not label
y-axis but add a title to each plot.

1.4 Develop a Simulink model with a sine wave input that feeds both a
double-sideband (DSB) AM block and a quantizer followed by a DSB
AM block. Assume a 2 s simulation and sine wave block parameters as
follows:

Sine wave amplitude= 2, Frequency= 20𝜋 rad/s, Sample time= 0.001 s.

For the DSB AM block, assume that the parameters are:

input signal offset = 1, carrier frequency = 100, initial phase = 0

a. Show the model with an included information block.

b. Assume the quantization interval = 0.5 and display the following sig-
nals in a scope with 4 traces:

sine wave output, DSB AM output, quantizer/DSB AM output, dif-
ference between the DSB AM output and quantizer/DSB AM output.

Provide titles for each trace and label only the x-axis.

c. Repeat part a with a quantization interval = 0.05.


